Introduction to Computers
Workbook 2011/2012

These lessons originally came from the CONNECT newsletter, a project of the Ottawa-Carleton
District School Board.
The Lessons for the Literacy Lab series was written by Diane McCargar, Elyse Schwartz, Liz
Devries and Catherine Hodgins and is available in Connect: Canada’s Resource Publication on
Technology and Adult Literacy - Vol 5, Issues 1-5, October/November 2002, December/January
2003, February/March 2003, April/May 2003 and June/July 2003.
This material is used with permission from the National Adult Literacy Database (NALD) Library online
collection: http://library.nald.ca/connect/.
The lesson plans were rewritten and the workbook revised for the Columbia Basin Alliance for
Literacy by Keri Russell and Margaret Sutherland in January 2011
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Lesson 1 - Handout 1

Parts of a Computer

9. _ _ _ _ _ _ _
10. _ _ _ _ _ _

11. _ _ _ _ _ _ _
8. _ _ _ _ _
____
12. _ _ _ _ _ _ _

7. _ _ / _ _ _
______

1. _ _ _ _ _ _ _ _

6. _ _ _ _ _

2. _ _ _ _ _ _ _ _ _
3. _ _ _ _ _ _ _ _ _ _

4. _ _

5. _ _ _ _ _ _
_____

on/off button

microphone

CD drive

screen

speaker

CD

monitor

mouse

tower

keyboard

memory stick

earphones
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Lesson 1 - Handout 2

Using Windows

14. _ _ _ _ _
15. _ _ _ _ _ _ _ _

12. _ _ _ _ _ _ _ _
13. _ _ _ _ _ _ _
___

16. _ _ _ _ _ _ _

11. _ _ _ _ _ _ _ _
_
10. _ _ _ _ _
9. _ _ _ _ _
8. _ _

2. _ _ _ _ _ _ _ _
1. _ _ _ _ _
____

7. _ _ _ _ _ _

4. _ _ _ _ _ _

3. _ _ _ _ _ _ _

5. _ _ _ _

6. _ _ _ _ _ _ _ _ _

desktop

programs

minimize

taskbar

folder

file

window

close

maximize

recycle bin

arrow

hard disk

CD

start menu

documents

icons
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Word Processing 1

Managing Documents
1

Run Word
1.

 Office Icon or the Start button.

2.

 Word Icon

2

Save a Document
1. 

4

1
2

2.

 Save As

3.

 a file name

4.

 Documents

5.

 a folder  (Computer Class)

6.

 Save

5

3

6

Print a Document
1.



2.

 Print

3.



1

3

2
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Word Processing 1

Managing Documents

Close a Document
1.



2.

 Close or

3.

 Exit

3

1
2

Create a New Document
1.



2.

 New

1
3

3.



4.

 Create

2

4
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Open a Document
1.



2.

 Open

3.

 Documents

4.

 a folder  (Computer Class)

5.

 a document

1
2
4
3

Exit Word
1.



2.



3.

 Exit

3
1
or

2

6

Using a Keyboard
Lesson 2 - Handout 1

The key you use to erase.
The key that starts a new line.
The key that makes a letter capital when you hold it down.
The key that makes all the letters capital until you push it again.
The bar that makes one space.
The period (.) key.
The key that makes a question mark (?) when you hold the shift key.
The comma (,) key.
The apostrophe (') key.
The key that moves you to the right when you start a paragraph.

Write the number on the correct key in the picture.
1.
2.
3.
4.
5.
6.
7.
8.
9.
10.

7

Lesson 2 - Handout 2

Typing Sentences

Type the sentences below with the correct capitalization, spacing and punctuation.

TYPING SENTENCES B
whataresomesafewaystoloseweight
crashdietsaredangerousanddontwork
drinkwaterinsteadofsugarydrinkslikejuiceandsoda
exerciseatleast3to5timesaweek
reducethesizeofyourmeals
doyoukeepeatingafteryourefull
doyoueatwhenyoureupsetorbored
eathealthysnacksduringtheday
donteatatnightwhileyouwatchtv
eatavarietyoffoodseveryday
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Word Processing 2

Editing Text and Spaces
][

End of Document



Mouse Pointer

Cursor

Inserting Text and Spaces

Inserting Lines

1.

 where you would like to insert text.

1.

 at the end of the previous line.

2.



2.

Press Enter.

Deleting Text and Spaces

Deleting Blank Lines

1.

 at the end of text.

1.

 on the line.

2.

Press Backspace.

2.

Press Backspace.

or

 to the left of a line.

Highlighting and Deleting
1.

Drag over text

or

  on a word

Today is Wednesday, February 11, 2012
2.

Press Backspace.
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Lesson 2 - Handout 3

Editing Text and Spaces

Instructions for making corrections to Four Bean Salad
1.
2.
3.
4.
5.
6.
7.

Type your name on the line above Four Bean Salad
Delete the s at the end of the word greens.
Delete the spaces between yellow and beans.
Add the word chopped after onion.
Delete the blank line after ¾ cup vinegar.
Add M before ix.
Add the word fridge between the and overnight.

Four Bean Salad
1 can greens beans
1 can yellow
beans
1 red onion
1 can chick peas
1 can kidney beans
3/4 cup sugar
3/4 cup vinegar
1/2 cup cooking oil
ix the first five ingredients together. Stir the remaining ingredients and pour over the beans.
Keep in the overnight.
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Lesson 2 - Handout 4
1.
2.
3.
4.
5.
6.
7.
8.
9.
10.

Editing Text and Spaces

Type your name on the line above Spicy Apple Muffins.
Double the recipe. (Example: change 2 c. all purpose flour to 4 c. all purpose flour)
Delete the blank line between white sugar and cinnamon.
Delete 1/2 c. cocoa.
Add the word Topping and a blank line between 1/3 c. melted butter and 1 tbsp. brown sugar.
Change 4000F to 400F.
Delete the extra spaces between muffin and tins.
Add the word Combine before egg, milk and melted butter.
Delete the word juice after liquid.
Change the word bottle to bowl.

Spicy Apple Muffins
2 c. all purpose flour
3 1/2 tsp. baking powder
1/2 tsp. salt
1/2 c. white sugar
1 tsp. cinnamon
1/4 tsp. nutmeg
1/4 tsp. cardamom
1 c. peeled chopped apple
1/2 c. cocoa
1 egg
1 c. milk
1/3 c. melted butter
1 tbsp. brown sugar
1/4 tsp. cinnamon
1/4 tsp. nutmeg
Preheat the oven to 4000F.
Grease muffin
tins.
Sift together flour, baking powder, salt and sugar in a mixing bowl.
Stir in chopped apple.
egg, milk and melted butter.
Add liquid juice to dry ingredients. Do not overmix.
Spoon into prepared muffin tins.
Topping
In a small bottle, combine brown sugar, cinnamon and nutmeg.
Sprinkle on tops of unbaked muffins.
Bake 15-20 minutes. Makes about 1 dozen muffins.
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Lesson 3 - Handout 1

Typing Paragraphs

Read the story. Fill in your information. Then type these paragraphs. Remember
to use ENTER to move to the next paragraph. Remember to use TAB to indent.
My name is _________________. I am a student here at _____________. I am ___
years old. I have ________ hair, _______eyes , and I’m very _________ today because
_____________________. Right now, I am sitting close to a person named __________.
This person’s last name is _____________. This person has ___________
hair and ________ eyes.
There are ________ people in the room. We are all learning about _______________.

Read the story. Then type these paragraphs. When you finish, you can type a
story about yourself.
My name is Liz Devries. I am an instructor at Ottawa Technical Learning Centre. I
teach English to adults. I am also a mother and I have three teenage children. I have a busy life.
Sometimes I am too busy and I get tired. One day when I was teaching, I looked down
and saw that my sweater was on inside out. That was embarrassing!
I’ve decided that I am going to try to be better organized in the future. I like to be busy,
but I don’t like to go around with my clothes on inside out! I will make sure that someone
checks my clothes before I go out the door every morning. Then I can be busy and happy too.
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Word Processing 3
1.

 on Review.

2.

 on Spelling and Grammar.

3.

If the correct spelling is listed

Checking Spelling
1
2

a)  on correct spelling.
b)  on Change.

4a)

3a)
)
4.

3b)
)3b

If a name isn’t in the dictionary
a)  on Ignore Once.

5.

If the correct spelling isn’t listed
a)  on mistake.
b) Correct mistake.

5a)
5b)

c)  on Change.

5c)
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Lesson 3 - Handout 2

Checking Spelling

To correct the mistakes in this school newsletter:
1. Put your cursor at the beginning of the document.
2.  Review.
3.  Spelling and Grammar.
4. Correct the spelling mistakes.
5. When the spelling check is complete, look for the mistakes the Spelling Tool
did not find. There is one wrong word in each paragraph.
The Class Communicator
January/February, 2012

Winter Isn’t So Bad!
by Derek Kartoum
In case you haven’t noticd, it’s cold outside! Many peuple want to hibernate like the
bears. Some people don’t even want to come to school. It’s so much easier to stay inside with
a cup of tea than to put on all those layers and brave the Arctic winds. But what happens if you
stay inside all the time? You get restless and depressed and irritable. Yous snap at your kids,
and after awhile you don’t fill like doing anything. This is smy advice. Go outside and find
something fun to do. You’ll be surprised to see how many other people are outsidehaving fun.
To enjoy the snow or ice, you need at least one of the following: a toboggan, a pair of ice
skates, a pair of snow soes or a pair of skis. You can ski or snow shoe anywhere in Ottawa or in
the Gatineau. There are lots of trails to follow. Their are also many toboggan hills, but the best
one is Conroy Pit near Hunt Club. The best place for ice skating is the Rideau Canal. It’s the
world’s longest skatting rink. Be sur eto check the condition of the ise. A green flag means
good; a yellow flag means not very good; a red flag means danger—don’t skate. The best time
to go skating is early in the morning. The canal isn’t crowded, and the ice is smooth because
they flood it with water ever ynight.
Norne of these activities costs much money. You can get used skates and skies at stores
that sell outdoor equipment. You can also rent skates and skis. It’s free to skate on the canal,
although sometimes they ask fer donations. Cross-country skiing, snow shoeing and
tobogganing are also free in Ottawa.
So, three’s no excuse for staying inside. Get out and enjy the winter! Take a thermos of
fot chocolate, wrap yourself up like a mummy, and do something active. Maybe I’ll see you
there. I’m thre won with the funny hat!
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Lesson 4 - Handout 1

Using Tabs

Write down at least 10 things you do every day. (Get up., Eat breakfast., Go to school., ...)
Write down the time you do each thing. (6:30 a.m., 7:45 a.m., 3:30 p.m., ...)
Type your schedule on the computer. Use the Tab key to move to the second column.

Personal Schedule
6:30 a.m.
_______
_______
_______
_______
_______
_______
_______
_______
_______

Get up.
_____________________________
_____________________________
_____________________________
_____________________________
_____________________________
_____________________________
_____________________________
_____________________________
_____________________________
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Lesson 4 - Handout 2

Using Tabs

Tab to 3” -->
440 Albert St.
Ottawa, ON
K1R 5B5
January 26, 2012
Greeting

Body

2 Enters
2 Enters

Dear Fran,
Thank you very much for the purple sweater. You must have spent a lot of
time knitting it. I appreciate all of your hard work. It fits well and it will keep me
very warm this winter. It was very kind of you to remember my birthday.

Closing

2 Enters

2 Enters

All the best,

Rita
You have received a gift from a friend.
Write him or her a thank-you letter for the gift.
______________
______________
______________
______________
_____________,
_____________________________________________________________________
__________________________________________________________________________
__________________________________________________________________________
__________________________________________________________________________
__________________________________________________________________________
__________________________________________________________________________
______________,
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Word Processing 5

Using the Font Group
Formatting using the Home Tab

Bold

Choose a Font
1.  on Font box.

Italic Underline

1

2.  on a font. (Arial)
3. .

2

Choose a Font Size

1

1.  on Font Size box.
2.  on a font size. (14)
3. .

2

Choose a Font Style

Change a Font after Typing

1. Highlight text.

1.  on Font Style button. 

2.  on Font, Font Size or Style.

2. .

3.

3.  on Font Style button again to turn it off.
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Lesson 5 - Handout 1

Using Fonts

Type this flyer for a garage sale. Try to use the same fonts, font sizes and styles
(B, I, U). You’ll need to use the Tab key.

GARAGE SALE
Saturday, May 7, 2012
8:00 AM TO 12:00 NOON
7631 OAK STREET

Dishes, CDs, tools, toys, and more…
You never know what
treasures you might find!
Cash Only

Rain Date: May 8
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Lesson 5 - Handout 2

Using Fonts

Type a flyer describing something you have lost. The flyer should include the
following information and use different fonts, font sizes and styles.
What did you lose?
What does it look like?
Where did you lose it?
When did you lose it?
Is there a reward?
What should I do if I find it?
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Word Processing 6-1

Using Alignments

Formatting using the Home Tab
Paragraph Group

Left

Centre

Right

Choose an Alignment
1.

 on an Alignment button.

2.

.

Change the Alignment after Typing
1.

Highlight lines.

2. on an Alignment button.
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Lesson 6 - Handout 1

Using Alignments

You are going to invite your friends to a party at your house.
Here is the information you need:
(1) the kind of party
(2) the date
(3) the time
(4) what people should bring
(5) your full name
(6) your address
(7) your phone number
Fill in the information about your party. Type your invitation. Make it look like the
one below. Try using different fonts. When you’re done, insert a picture in your
invitation.

You’re invited to my (1) _____________________ party!
on (2) ____________________________________
at (3) ___________________
Please bring (4) __________________________

(5) _____________________________
(6) _____________________________
(7) _____________________________
Please RSVP
See you there!
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Word Processing 6-2

Using Pictures

Insert a Picture

1

1.  on the Insert tab.

2

2.  on Clip Art.

3

3.  a category (animals).

4

4. Go
5.  on a picture.

5

Resize a Picture
1.  on the picture.
2. Drag a sizing handle.

2
1

Move a Picture
1. Point to the center of the picture.
2. Use the Symbol

to Drag.
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Word Processing 6-3

Using Pictures

Position a Picture
1.  on the picture.

2

3

1

2.  on Picture Tools
3.  on Position (located in the Arrange group).

4

4.  on





Wrap Text Around a Picture
5.  on the picture.

7

6.  on Picture Tools
7.  on Wrap Text (located in the Arrange group).
8.  on Wrapping Style you want.

8
9

10
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Word Processing 7

Cut, Copy and Paste
Home Tab
Paste Cut Copy

Copy and Paste
2

1. Highlight text.
2.  Copy.
3.  where you want text.

4

4.  Paste.

Cut and Paste
2

1. Highlight text.
2.  Cut.
3.  where you want text.

4

4.  Paste.
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Lesson 7 - Handout 1
1.
2.
3.

Copy and Paste

Read about the diseases on this handout.
Look at the immunization schedule given to you by your instructor.
Copy the name of each disease and paste it beside the age that requires this
immunization.

Immunization can protect a child from the serious diseases described here. Always check with your doctor.
DIPTHERIA –This is a serious infection that can cause breathing problems, heart failure, paralysis and death.
HEPATITIS B – This is a virus that can cause serious liver problems.
POLIO myelitis – This is a virus that can cause paralysis and death.
HIB (Haemophilus B) – This is a bacteria that can infect any part of the body. The infection can lead to severe
joint problems, pneumonia, brain damage and even death.
MEASLES – This disease causes rash, high fever, cough, runny nose and watery eyes. It can cause ear
infections, pneumonia, hearing loss, brain damage and even death.
MUMPS – This disease causes fever, headache and painful swelling of the glands in the mouth and neck.
PERTUSSIS – This is also called whooping cough. It causes severe coughing for weeks or months. The risk
of complications is greatest in children under seven.
TETANUS – This is also called lockjaw. It causes painful muscle spasms, breathing failure and even death.
RUBELLA – This is also called German Measles. It causes fever, rash, swelling of the neck and painful joints.
If a pregnant woman gets rubella, it is very dangerous for the unborn baby.
IMMUNIZATION SCHEDULE
2 months
4 months
6 months
12 months
18 months
4 to 6 years
14 to 16 years
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Lesson 7 - Handout 2
and Paste

Copy and Paste

Routine Immunization Schedule for Infants and Children
Age at
vaccination

Diptheria
Pertussis
Tetanus
Polio

HIB

Measles
Mumps
Rubella
(MMR)

Birth

Hepatitis B
Infancy
3 doses

2 months
4 months
6 months
12 months
18 months
4-6 years

or

or

14-16 years

Pre-teen/teen 2-3
doses
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Lesson 7 - Handout 3
1.
2.

Cut and Paste

Look at the items written below.
Cut and paste each item into the correct box.
glass bottles

newspapers

milk bags

pop cans

jar lids

tin cans

light bulbs

pots and pans

waxed paper

pizza boxes

cereal boxes

chip bags

toilet paper rolls

books

plastic bags

pottery

foil

aluminum pie plates

gift wrap

shoe boxes

magazines

telephone books

cardboard

flyers

CAN RECYCLE

CANNOT RECYCLE
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Lesson 8 - Handout 1

Numbered Lists

Instructions:
1.
Type the text below.
2. Use the number button in the Paragraph group to type the numbered list.

Handwashing Keeps the Germs Away
The most important thing you can do to keep from getting sick is to
wash your hands.
By frequently washing your hands you wash away germs that you
have picked up from other people, or from contaminated surfaces, or from
animals and animal waste.
“An ounce of prevention is worth a
pound of cure!”
Here is the correct way to wash your hands:
1. Use soap and warm running water.
2. Rub your hands vigorously for at least 20 seconds.
3. Wash all surfaces including the backs of your hands, wrists, between
fingers, under fingernails.
4. Rinse well. Leaving soap on your hands will lead to drying and
cracking of your skin.
5. Dry your hands well with a paper towel.
6. Turn off the tap with the paper towel you used to dry your hands. This
prevents picking up the germs that were on your hands when you
turned on the tap.
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Lesson 8 - Handout 2

Bulleted Lists

Type the text below. Use the Bullet button on the Toolbar.

What can we do to prevent West Nile infection?
Avoid mosquito bites.
• Apply insect repellent to exposed skin when you go outdoors. Be careful putting
repellent on children. Don’t put it on their hands and avoid their mouths and eyes.
• Wear protective clothing such as long sleeves, long pants, and socks while outdoors.
• Spray clothing with repellents containing DEET or permethrin.
• Try to stay indoors between dusk and dawn.
• Avoid activities in areas where there are many mosquitoes.
• Fix or install window and door screens to keep mosquitoes out of buildings.
Always read and follow the product directions when using any insect repellent or insecticide!
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Lesson 9 - Handout 1

Business Letters

Instructions:
1.
Read the sample complaint letter.
2. Type either a complaint or a thank you letter to an elected official
(your Mayor, MLA or MP). Find the address on the internet.
Return Rachel Greene
Address 1203 - 440 Albert Street
(From:) Ottawa, Ontario
K2T 1V0

Date May 23, 2012

Inside Frank Moore
Address Minto Apartments
(To:) 1B – 440 Albert Street
Ottawa, Ontario
K2T 1V0
Greeting Dear Mr. Moore:

2-4 Enters

2-4 Enters

2 Enters
2 Enters

Body I am writing to you because the hot water tap in my bathroom is dripping. I mentioned
this to the superintendent on Monday, May 12, 2012 and he said he would fix it that
week. It is almost two weeks later and it still hasn’t been fixed. It isn’t a big problem but
the wasted hot water is costing me money on my heating and water bills.

2 Enters

I would appreciate it if you could speak to the superintendent about this problem. I’d like
to know when the problem will be fixed.

2 Enters

Closing Sincerely,

6 Enters

Signature
Name Rachel Greene
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Word Processing 10

Using Tables
Tables

Column

Cell
Headings
Row

Last Name

First Name

Address

City

Province

Postal Code

Hamelin

Martin

2351 Park Road

Halifax

NS

B3J 2S9

Thorn

Teresa

76 Spring Garden Road

Halifax

NS

B3J 5M9

Border

Gridline

Create a Table

1

1.  on Insert.

2

2.  on Table.
3. Drag to highlight the number of rows and columns.
4.  to insert table.

3

Entering Information
1. Click in a cell.
2. 
3. Press Tab.

Change Height or Width

1

2

1. Hover over gridline.
2. Drag line when you see two arrows.
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Using Tables

Word Processing 10
Highlight
Cell
Column
Row

 on the left edge of the cell.
 above the column.
 to the left of the row.

Delete Rows and Columns
2

1.  row or column.
2.  on Layout tab.
3.  on Delete.
4.  on Delete Columns

3
4

or Delete Rows.

Insert Rows and Columns
1.  in any cell.
2.  on Layout tab.
3.  on Insert Above, Insert Below, Insert Left, or Insert Right.

2
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Borders
1.  in any cell.

3
2

2.  on Design tab.
3.  on type of border.

3

Borders
1. Highlight Cells.
2.  on a text format from the Font or Paragraph group (Bold, Centre, 18 point, etc.)

2
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Lesson 10 - Handout 1

Creating Tables

Instructions:
1.
Insert a table with 4 columns and 7 rows.
2.
Type the headings.
3.
Write each word below in the correct column of the table (six words for
each column).
4.
Type one word in each cell.
drank

beautiful

sing

think

quickly

backyard

always

engineer

flowers

hungry

run

did

go

tennis

song

sunny

yesterday

strong

never

softly

blue

happily

Canada

three

Adjectives

Nouns

Verbs

Adverbs
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Lesson 11 - Handout 1

Formatting Tables

Instructions:
1.
Put borders around all of the cells in the table.
2.
Make the headings bold.
3.
Make all the last names bold.
4.
Centre all of the phone numbers.
5.
Make the Address column wider so the addresses fit on one line.
6.
Insert a City column before the Phone Number column.
7.
All of the people live in Ottawa. Type Ottawa in the City column.
8.
Add a Postal Code column after the City column.
9.
Type the following postal codes: Chi – K5B 1R1, Gerald – K0S 4X2,
Ben – K0A 2T1, Manuel – K0S 3T8, Tina – K7V 3S4
10. Insert a row to add Pierre Azar to the table. The names should be in
alphabetical order.
11. Type Pierre’s information
Azar
Pierre
15 Woodridge Cr.
Nepean
749-2342
12. Insert the following names in the table in alphabetical order.
Gratton Marie
2453 Kent Ave.
Ottawa
643-2762
Dana
Walid
167 Aspen Way
Orleans
837-8756
Tessier
Jean
873 Emperor Ave.
Nepean
756-9257
Tennant Ivan
7545 Carson Road
Ottawa
753-8754
13. Delete Gerald Chen from the table.
Last Name
Chen

First Name
Chi

Chen
Green
Rodriguez
Van Walraven

Gerald
Ben
Manuel
Tina

Address
20A Meadowlands
Drive
187 James Crt.
234 Main St.
78 Pearson Ave.
252 Cedarbank
Road

Phone Number
765-8795
872-3542
231-2387
453-7855
364-9876
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Word Processing 12
Change Margins

1.  on Page Layout.

Margins are
the areas
around the
outside of the
paper

Page Setup
4

Margins

2

1

2.  on Margins.
3.  on Custom Margins.
4.  size of margins.
5.  on OK.

Change Paper Size

3

5

1

1.  on Page Layout.

2

2.  on Size.
3.  on a paper size.

3
8 ½”
11”

Letter

8 ½”
Legal

14”

Change Paper Orientation

Portrait

1.  on Page Layout

2

1

2.  on Orientation.
3.  on Portrait or Landscape.

Landscape

3
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Lesson 12 - Handout 1

Page Setup

Instructions:
1.
Change the Margins to 0.5 inches.
2.
Change the Orientation to landscape.
3.
Create a table with 7 columns and 11 rows.
4.
Type the headings given.
5.
Fill in the table. Use the Telus website to find numbers you don’t know.
(www.mytelus.com)

Last Name

First Name

Address

City

Province

Postal Code

Phone #
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Lesson 12 - Handout 2

Resumes

Instructions:
1. Change all the margins to 0.5 inches.
2. Insert a table with 3 columns and 9 rows. Remove the borders.
3. Make the first column 2 inches, the second column 3 1/2 inches & the third column 2 inches.
4. Type the resume below. Type each section in a different row.
5. Format the information. Make the headings, the name, and the job titles bold. Make the
company names italic. Centre the name, address and phone number. Right align the job
addresses and dates. Use bullets for the job duties.

Frank Wendover

34 Main Street, Apt. 231
Edmonton, Alberta T5T 2X9
(613) 746-0583
GOAL:
QUALIFICATIONS:

EXPERIENCE:

EDUCATION:
INTERESTS:
REFERENCES:

To obtain employment as a heavy equipment
operator or a labourer
 Hardworking and reliable
 St. John’s Ambulance first-aid training
 Class 3 driver’s licence
 Experience using heavy equipment
Habitat for Humanity
Volunteer
 Framed windows
 Installed drywall
 Installed asphalt shingles
Johnson Construction
Heavy Equipment Operator
 Operated heavy equipment to move, load and
unload building supplies
 Operated backhoes and bulldozers to
excavate, move and load earth
City of Winnipeg
Labourer
 Operated street cleaning equipment
 Spread sand/salt for snow and ice control
 Repaired road surfaces
 Operated mowers to cut lawns and roadsides
Manford Secondary School
Secondary School Diploma
 Fishing
 Antique Cars
Available upon request

Edmonton, Alberta
July 2009-present

Winnipeg, Manitoba
1999-2008

Winnipeg, Manitoba
1995-1998

Winnipeg, Manitoba
1995
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Lesson 12 - Handout 3

Resumes

___________________________ (name)
________________________________ (address)
_________________, _______________ ______
( ____ ) _______________ (phone no.)
GOAL:

To obtain employment as a __________________

QUALIFICATIONS:

 ___________________________________
 ___________________________________
 ___________________________________
 ___________________________________

______________________________ (Company)
______________________________ (Job Title)
 ______________________________(Duties)
 ___________________________________
 ___________________________________
 ___________________________________
______________________________ (Company)
______________________________ (Job Title)
 ______________________________(Duties)
 ___________________________________
 ___________________________________
 ___________________________________
______________________________ (Company)
______________________________ (Job Title)
 ______________________________(Duties)
 ___________________________________
 ___________________________________
 ___________________________________

EXPERIENCE:

EDUCATION:

________________________________ (School)
_______________________________ (Course)
________________________________ (School)
_______________________________ (Course)

INTERESTS:





REFERENCES:

Available upon request

_______, ______(address)
_______ to _______ (date)

_______, ______(address)
_______ to _______ (date)

_______, ______(address)
_______ to _______ (date)

_______, ______(address)
_______ to _______ (date)
_______, ______(address)
_______ to _______ (date)

___________________________________
___________________________________
___________________________________
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